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1. When you run the Spell Checker in a workbook, Excel automatically checks the spelling in all worksheets at once. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.4.1 - Check spelling. 

CORPORATE STANDARDS:   1144 - Check spelling. 

TOPICS:   Illustrated series: Checking Spelling 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   7/31/2019 4:18 AM 

DATE MODIFIED:   8/30/2019 2:16 AM 
 

 

2. Currency is an example of a number format. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-3 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   565 - Apply the Currency number format. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   7/31/2019 4:21 AM 

DATE MODIFIED:   7/31/2019 4:23 AM 
 

 

3. You can apply date formats to cells by using the Date category in the Format Cells dialog box. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-3 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   567 - Apply the Date number format. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Understand 
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DATE CREATED:   7/31/2019 4:23 AM 

DATE MODIFIED:   7/31/2019 4:25 AM 
 

 

4. To remove conditional formatting from a selected range, you can select the rule in the Conditional Formatting Rules 

Manager dialog box, then click the Delete Rule button. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-15 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.2 - Manage conditional formatting rules. 

CORPORATE STANDARDS:   1742 - Delete a conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   7/31/2019 4:25 AM 

DATE MODIFIED:   7/31/2019 4:27 AM 
 

 

5. To change the background color of a cell, you use the Background color button. 

ANSWER:   False - Fill 

False - fill 
False - FILL 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   833 - Change the fill color of a cell. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   7/31/2019 4:28 AM 

DATE MODIFIED:   8/25/2019 10:34 PM 
 

 

6. To format the cell value 44.54 as 44.540, you can use the Increase Decimal button. 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-2 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 
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CORPORATE STANDARDS:   2410 - Increase the number of displayed decimal places. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/26/2019 12:34 AM 

DATE MODIFIED:   8/26/2019 12:37 AM 
 

 

7. To apply formats to data when it meets  criteria you specify, you can use conditional formatting. 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-15 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1369 - Create a conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/26/2019 12:29 AM 

DATE MODIFIED:   8/30/2019 2:45 AM 
 

 

8. Which of the following is true of the Excel spell checker? 

  a.  You can change all instances of a flagged word to a selected suggestion. 

  b.  You cannot add words to the spell checker dictionary. 

  c.  You must accept all spell checker suggested replacement words. 

  d.  For multiple instances of a misspelled word, you must change each one individually. 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.4.2 - Accept suggested spelling changes. 

CORPORATE STANDARDS:   1 - Accept all instances of suggested spelling change. 

TOPICS:   Illustrated series: Check Spelling 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 5:45 AM 

DATE MODIFIED:   8/25/2019 10:36 PM 
 

 

9. To accept a suggested spelling for that instance only, which of the following would you click? 

  a.  Change 

  b.  Change All 

  c.  Ignore Once 

  d.  Add to Dictionary 

ANSWER:   a 
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POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.4.2 - Accept suggested spelling changes. 

CORPORATE STANDARDS:   6 - Accept suggested spelling change. 

TOPICS:   Illustrated series: Check Spelling 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 5:49 AM 

DATE MODIFIED:   8/1/2019 5:53 AM 
 

 

10. Which of the following is true about adding cell borders? 

  a.  A cell border changes the background color of the cell. 

  b.  A cell border underlines the cell content. 

  c.  You can add a border to the left, top, right, or bottom edge of a cell. 

  d.  Borders are always single black lines. 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   19 - Add a border to a cell. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 5:53 AM 

DATE MODIFIED:   6/3/2020 6:13 PM 
 

 

11. Clicking the Percentage style in the Number Format list applies _____ decimal places by default. 

  a.  one 

  b.  two 

  c.  three 

  d.  four 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-2 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   577 - Apply the Percentage number format. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Remember 
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DATE CREATED:   8/1/2019 5:57 AM 

DATE MODIFIED:   8/30/2019 2:20 AM 
 

 

12. To help you easily identify sheets in a workbook, you can add _____ to the sheet tab. 

  a.  Alignment 

  b.  Fonts 

  c.  Color 

  d.  Styles 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.1 - Change worksheet tab color. 

CORPORATE STANDARDS:   802 - Change the color of a worksheet tab. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 6:03 AM 

DATE MODIFIED:   8/30/2019 2:46 AM 
 

 

13. To format a range so that all values greater than $500 appear in red, which of the following can you use? 

  a.  conditional formatting 

  b.  cell formatting 

  c.  cell styles 

  d.  Quick Access toolbar 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-15 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1369 - Create a conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:07 AM 

DATE MODIFIED:   8/1/2019 6:11 AM 
 

 

14. Your worksheet contains confidential information in column C; to prevent others who use your worksheet from seeing 

the data, you can _____ column C. 

  a.  delete 

  b.  conditionally format 

  c.  edit 

  d.  hide 
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ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-11 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.5.2 - Hide and unhide columns and rows. 

CORPORATE STANDARDS:   2318 - Hide a column. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:12 AM 

DATE MODIFIED:   8/30/2019 2:48 AM 
 

 

15. You receive a worksheet in which the row numbers are 1, 2, 3, 5, 6. This means that row 4 is  _____. 

  a.  deleted 

  b.  hidden 

  c.  cut 

  d.  conditionally formatted 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-11 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.5.2 - Hide and unhide columns and rows. 

CORPORATE STANDARDS:   2323 - Hide a row. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Apply 

DATE CREATED:   8/1/2019 6:15 AM 

DATE MODIFIED:   6/3/2020 6:14 PM 
 

 

16. The spell checker flags your company's name as a misspelling. Which of the following will stop the spell checker 

from flagging later occurrences in the document? 

  a.  Change All 

  b.  Change 

  c.  Ignore Once 

  d.  Ignore All 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.4.3 - Ignore suggested changes. 

CORPORATE STANDARDS:   2349 - Ignore all instances of suggested spelling change. 
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TOPICS:   Illustrated series: Check Spelling 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:19 AM 

DATE MODIFIED:   8/25/2019 11:51 PM 
 

 

17. To change conditional formatting that applies a red fill color to one that applies a green fill color, which of the 

following can you do? 

  a.  Delete the conditional formatting rule. 

  b.  Edit the conditional formatting rule. 

  c.  Format the range in the Font dialog box. 

  d.  Format the range as a table. 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-15 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.2 - Manage conditional formatting rules. 

CORPORATE STANDARDS:   1968 - Edit a conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:23 AM 

DATE MODIFIED:   6/3/2020 6:15 PM 
 

 

18. Which of the following are ways to align cell contents in relation to cell edges? Select all the options that apply. 

  a.  left 

  b.  center 

  c.  bold 

  d.  underline 

ANSWER:   a, b 

POINTS:   1 

REFERENCES:   ILEX 2-7 

QUESTION TYPE:   Multiple Response 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.2 - Modify cell alignment and indentation. 

CORPORATE STANDARDS:   348 - Align cell contents horizontally. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:26 AM 

DATE MODIFIED:   8/30/2019 2:49 AM 
 

 

19. The Comma Style format adds a comma and a dollar sign to a cell value. 

  a.  True 

  b.  False 
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ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-2 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   559 - Apply the Comma number format. 

TOPICS:   Illustrated series: Formatting the Worksheet 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 6:35 AM 

DATE MODIFIED:   8/25/2019 11:55 PM 
 

 

20. A predesigned combination of formats, such as font size and color, is called a cell default. 

ANSWER:   False - style 

False - STYLE 

False - Style 

POINTS:   1 

REFERENCES:   ILEX 2-4 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.7 - Apply cell styles. 

CORPORATE STANDARDS:   414 - Apply a cell style. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:40 AM 

DATE MODIFIED:   8/1/2019 6:43 AM 
 

 

21. When you wrap and center a range, you combine the cells into one cell. 

ANSWER:   False - merge 

False - Merge 

False - MERGE 

POINTS:   1 

REFERENCES:   ILEX 2-6 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.1 - Merge cells. 

CORPORATE STANDARDS:   2833 - Merge and center cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:44 AM 

DATE MODIFIED:   6/3/2020 6:20 PM 
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22. When you double-click the right border of a column heading, which of the following occurs ? 

  a.  The column is deleted. 

  b.  AutoFit resizes the column to 8.43 characters wide. 

  c.   A column is added to the right of the current column. 

  d.  AutoFit resizes the column to the widest cell entry. 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-8 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.7 - Adjust row height and column width. 

CORPORATE STANDARDS:   3391 - Resize a column using AutoFit. 

TOPICS:   Illustrated series: Adjust Column Width 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 6:47 AM 

DATE MODIFIED:   6/3/2020 6:16 PM 
 

 

23. To change the color of cell content, you use the ________ color list arrow. 

  a.  Cell 

  b.  Text 

  c.  Pattern 

  d.  Font 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   837 - Change the font color of cell content. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:51 AM 

DATE MODIFIED:   8/1/2019 6:53 AM 
 

 

24. A _____ is the appearance and shape of letters, numbers, and special characters. 

  a.  symbol 

  b.  font 

  c.  point 

  d.  keyword 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-4 
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QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   844 - Change the font of cell content. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:54 AM 

DATE MODIFIED:   6/3/2020 6:20 PM 
 

 

25. The default worksheet text is _____-point Calibri. 

  a.  10 

  b.  11 

  c.  12 

  d.  14 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-4 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   850 - Change the font size of cell content. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 6:58 AM 

DATE MODIFIED:   8/1/2019 7:02 AM 
 

 

26. To return cell contents to its default font and style, you can use the _____ command. 

  a.  Clear Formats 

  b.  Clear Contents 

  c.  Clear All 

  d.  Clear Comments 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   1172 - Clear cell formatting. 

TOPICS:   Illustrated series: Check Spelling 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:24 AM 

DATE MODIFIED:   8/1/2019 7:27 AM 
 

 



Name:   
 

 Class:   
 

 Date:   
 

 

Excel Module 02 

 

Copyright Cengage Learning. Powered by Cognero. Page 11 
 

27. When you underline cell content, you are using _____. 

  a.  a font style 

  b.  an orientation setting 

  c.  an indent setting 

  d.  a centering style 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-6 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   4409 - Underline cell content. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 7:27 AM 

DATE MODIFIED:   8/1/2019 7:30 AM 
 

 

28. The _____ number format adds dollar signs and two decimal places to numeric data. 

  a.  Data 

  b.  Accounting 

  c.  Percentage 

  d.  General 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-2 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   551 - Apply the Accounting number format. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:31 AM 

DATE MODIFIED:   6/3/2020 6:25 PM 
 

 

29. To apply a cell style, you would use the Cell Styles command on the _____ tab. 

  a.  Layout 

  b.  Insert 

  c.  View 

  d.  Home 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-4 
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QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.7 - Apply cell styles. 

CORPORATE STANDARDS:   414 - Apply a cell style. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:34 AM 

DATE MODIFIED:   8/1/2019 7:37 AM 
 

 

30. To combine multiple cells into one combined cell, which of the following do you use? 

  a.  Column Width command 

  b.  Center button 

  c.  Merge and Center button 

  d.  Increase Indent button 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-7 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.1 - Merge cells. 

CORPORATE STANDARDS:   2839 - Merge cells. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:37 AM 

DATE MODIFIED:   8/30/2019 2:50 AM 
 

 

31. Which of the following lets you apply bold formatting to a selected cell? Select all the options that apply. 

  a.  Bold button 

  b.  CTRL+B 

  c.  CTRL+D 

  d.  Clear button 

ANSWER:   a, b 

POINTS:   1 

REFERENCES:   ILEX 2-7 

QUESTION TYPE:   Multiple Response 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   622 - Bold cell content. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:51 AM 

DATE MODIFIED:   6/3/2020 6:35 PM 
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32. To check your workbook for features that assist people with disabilities, you can use the Ability Checker. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-13 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.6.6 - Inspect a workbook for accessibility issues. 

CORPORATE STANDARDS:   1150 - Check worksheet accessibility. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 7:56 AM 

DATE MODIFIED:   8/25/2019 11:59 PM 
 

 

33. To make your workbooks usable by people with disabilities, you can use the Accessibility Checker in Excel. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-13 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.6.6 - Inspect a workbook for accessibility issues. 

CORPORATE STANDARDS:   1150 - Check worksheet accessibility. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 7:58 AM 

DATE MODIFIED:   6/3/2020 6:36 PM 
 

 

34. Decreasing a cell's indent moves its contents to the right one space. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-17 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   1716 - Decrease the indent of cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Understand 
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DATE CREATED:   8/1/2019 8:01 AM 

DATE MODIFIED:   8/1/2019 8:03 AM 
 

 

35. When you change cell contents to italics, you are changing the cell's alignment. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-7 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   2751 - Italicize cell content. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:03 AM 

DATE MODIFIED:   8/1/2019 8:08 AM 
 

 

36. When you insert a worksheet row, a row is inserted above the cell pointer and the sheet contents move downward. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-10 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.5 - Insert and delete worksheet cells, columns, and rows. 

CORPORATE STANDARDS:   2596 - Insert a row. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:08 AM 

DATE MODIFIED:   8/30/2019 2:54 AM 
 

 

37. To move a worksheet, you can drag its sheet tab to the left or right. 

  a.  True 

  b.  False 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-16 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.3 - Change worksheet order. 

CORPORATE STANDARDS:   2939 - Move a worksheet. 



Name:   
 

 Class:   
 

 Date:   
 

 

Excel Module 02 

 

Copyright Cengage Learning. Powered by Cognero. Page 15 
 

TOPICS:   Illustrated series: Rename and Move a Worksheet 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:11 AM 

DATE MODIFIED:   8/1/2019 8:14 AM 
 

 

38. When you select a cell range, the cells must be adjacent to each other. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-4 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.2.2 - Select cells and ranges. 

CORPORATE STANDARDS:   3767 - Select nonadjacent cells. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:14 AM 

DATE MODIFIED:   8/26/2019 12:02 AM 
 

 

39. To move cell contents one space to the right, you can use the Increase Space button. 

ANSWER:   False - Indent 

False - indent 

False - INDENT 

POINTS:   1 

REFERENCES:   ILEX 2-17 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.2 - Modify cell alignment and indentation. 

CORPORATE STANDARDS:   2407 - Increase the indent of cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:16 AM 

DATE MODIFIED:   8/26/2019 12:03 AM 
 

 

40. To rotate cell contents, you use the Orientation button in the Alignment group on the Home tab. 

ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-7 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 
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LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   3590 - Rotate cell content to a preset angle. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/26/2019 12:20 AM 

DATE MODIFIED:   6/3/2020 6:31 PM 
 

 

41. Which of the following is not true about setting column width? 

  a.  The column width measurement is based on characters. 

  b.  The default column width is 8.43. 

  c.  You can change the width of only one column at a time. 

  d.  You can use the Format button in the Cells group to set an exact column width. 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-8 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.7 - Adjust row height and column width. 

CORPORATE STANDARDS:   3390 - Resize a column to an exact value. 

TOPICS:   Illustrated series: Adjust Column Width 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:25 AM 

DATE MODIFIED:   6/3/2020 6:38 PM 
 

 

42. To rotate cell contents to an exact value, you change its _____. 

  a.  Font 

  b.  Width 

  c.  Indent 

  d.  Orientation 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-17 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.5 - Apply cell formatting. 

CORPORATE STANDARDS:   3591 - Rotate cell content to an exact value. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:28 AM 

DATE MODIFIED:   8/1/2019 8:31 AM 
 

 

43. To copy a cell's formatting to another cell, which of the following can you use? 

  a.  Format Cells dialog box 
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  b.  Format Painter 

  c.  Quick Analysis Tool 

  d.  Format as Table 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-6 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.6 - Format cells by using format painter and AutoFill. 

CORPORATE STANDARDS:   4548 - Use the Format Painter with cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:31 AM 

DATE MODIFIED:   8/1/2019 8:34 AM 
 

 

44. You double-click the Format Painter button when you want to _____. 

  a.  copy a cell's data to another cell 

  b.  paste the same format multiple times 

  c.  paste conditional formatting only 

  d.  clear a cell's formatting 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-6 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.6 - Format cells by using format painter and AutoFill. 

CORPORATE STANDARDS:   4548 - Use the Format Painter with cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:35 AM 

DATE MODIFIED:   6/3/2020 6:22 PM 
 

 

45. Which of the following is true about deleting a worksheet row? 

  a.  After you delete a row, the rows below it shift down one row. 

  b.  To delete a row, you can select the row, then press the DELETE key on the keyboard. 

  c.  To delete a row, you can select the row, then use the Delete button in the Cells group. 

  d.  If you select a row and click the Delete list arrow, you can select Delete Sheet to delete the row. 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-10 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 
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LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.5 - Insert and delete worksheet cells, columns, and rows. 

CORPORATE STANDARDS:   1775 - Delete a row. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:40 AM 

DATE MODIFIED:   8/1/2019 8:45 AM 
 

 

46. To delete a  worksheet column, you can first select it by _____. 

  a.  clicking the column heading 

  b.  double-clicking the column heading 

  c.  clicking anywhere in the column 

  d.  double-clicking anywhere in the column 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-10 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.5 - Insert and delete worksheet cells, columns, and rows. 

CORPORATE STANDARDS:   1738 - Delete a column. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:46 AM 

DATE MODIFIED:   8/1/2019 8:50 AM 
 

 

47. After you delete a worksheet column, _____. 

  a.  the columns to its right shift left 

  b.  the columns to its left shift right 

  c.  the row remains but its contents are deleted 

  d.  only its formats are deleted 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-10 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.5 - Insert and delete worksheet cells, columns, and rows. 

CORPORATE STANDARDS:   1738 - Delete a column. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 8:50 AM 

DATE MODIFIED:   8/1/2019 8:53 AM 
 

 

48. You need to add another product to your inventory worksheet, which shows product names in  row A. Which of the 

following should you add? 
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  a.  a row 

  b.  a column 

  c.  a button 

  d.  conditional formatting 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-10 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.5 - Insert and delete worksheet cells, columns, and rows. 

CORPORATE STANDARDS:   2469 - Insert a column. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:54 AM 

DATE MODIFIED:   8/1/2019 8:57 AM 
 

 

49. To rename a worksheet, you change the text on the  _____. 

  a.  sheet columns 

  b.  sheet rows  

  c.  sheet header 

  d.  sheet tab 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-16 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.2 - Rename a worksheet. 

CORPORATE STANDARDS:   3340 - Rename a worksheet. 

TOPICS:   Illustrated series: Rename and Move a Worksheet 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 8:57 AM 

DATE MODIFIED:   6/3/2020 6:39 PM 
 

 

50. To select nonadjacent cells or ranges on a worksheet, you can press and hold _____ while selecting each one. 

  a.  CTRL 

  b.  ALT 

  c.  SHIFT 

  d.  ESC 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-4 

QUESTION TYPE:   Multiple Choice 
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HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.2.2 - Select cells and ranges. 

CORPORATE STANDARDS:   3767 - Select nonadjacent cells. 

TOPICS:   Illustrated series: Change Font and Font Size 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 9:01 AM 

DATE MODIFIED:   8/1/2019 9:04 AM 
 

 

51. Clicking the Increase Decimal button in the Number group would change the displayed cell value 14.54 to 14.5. 

  a.  True 

  b.  False 

ANSWER:   False 

POINTS:   1 

REFERENCES:   ILEX 2-2 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.4 - Apply number formats. 

CORPORATE STANDARDS:   1717 - Decrease the number of displayed decimal places. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 9:10 AM 

DATE MODIFIED:   8/1/2019 9:14 AM 
 

 

52. To format a cell range so that values between 100 and 500 appear in red, which of the following can you use? 

  a.  icon sets 

  b.  themes 

  c.  Top/Bottom Rules 

  d.  Highlight Cells Rules 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-14 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1513 - Create a highlight cells conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 9:15 AM 

DATE MODIFIED:   8/1/2019 9:19 AM 
 

 

53. To insert information that appears at the bottom of every worksheet page, you can use a command on the Insert tab. 

  a.  True 

  b.  False 
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ANSWER:   True 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   True / False 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.8 - Manage headers and footers. 

CORPORATE STANDARDS:   2496 - Insert a footer. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:25 AM 

DATE MODIFIED:   8/1/2019 10:26 AM 
 

 

54. A worksheet named Income (2) is most likely which of the following? 

  a.  a deleted worksheet 

  b.  a worksheet with no calculations 

  c.  a repositioned worksheet 

  d.  a copy of another worksheet named Income 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-17 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.1.4 - Copy a worksheet. 

CORPORATE STANDARDS:   1318 - Copy a worksheet. 

TOPICS:   Illustrated series: Rename and Move a Worksheet 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 10:28 AM 

DATE MODIFIED:   8/1/2019 10:32 AM 
 

 

55. Which of the following methods copies an existing worksheet within the same workbook? 

  a.  Drag its sheet tab to a new location. 

  b.  Press and hold CTRL and drag its sheet tab to a new location. 

  c.  Press and hold SHIFT and drag its sheet tab to a new location. 

  d.  Press and hold ALT and drag its sheet tab to a new location. 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-17 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.1.4 - Copy a worksheet. 

CORPORATE STANDARDS:   1318 - Copy a worksheet. 

TOPICS:   Illustrated series: Rename and Move a Worksheet 
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KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 10:33 AM 

DATE MODIFIED:   8/1/2019 10:36 AM 
 

 

56. Elise is preparing to print a worksheet that displays the worksheet name centered at the bottom of every page. She also 

wants to display the current date next to the worksheet name. Which of the following should she do? 

  a.  Edit the footer to add the date. 

  b.  Add a header to display the date. 

  c.  Add the date to a worksheet cell. 

  d.  Add a document property showing the current date. 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.8 - Manage headers and footers. 

CORPORATE STANDARDS:   1971 - Edit a footer. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:37 AM 

DATE MODIFIED:   6/27/2020 4:08 PM 
 

 

57. To enter your name in the lower right corner of a worksheet page, you can _____. 

  a.  Use a button on the Header and Footer Tools Design tab. 

  b.  Type your name in the Header and Footer Elements group. 

  c.  Type your name in the lower right cell of the worksheet. 

  d.  Select the right footer text box and type your name. 

ANSWER:   d 

POINTS:   1 

REFERENCES:   ILEX 2-12 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.4.8 - Manage headers and footers. 

CORPORATE STANDARDS:   2076 - Enter text in a footer. 

TOPICS:   Illustrated series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:40 AM 

DATE MODIFIED:   8/1/2019 10:44 AM 
 

 

58. To format text so that it automatically appears in multiple lines within a cell, you can transpose it. 

ANSWER:   False - wrap 

False - Wrap 

False - WRAP 
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POINTS:   1 

REFERENCES:   ILEX 2-6 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.2.3 - Wrap text within cells. 

CORPORATE STANDARDS:   4602 - Wrap cell contents. 

TOPICS:   Illustrated series: Change Font Styles and Alignment 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:45 AM 

DATE MODIFIED:   8/26/2019 12:10 AM 
 

 

59.  If a worksheet contains cells with blue fills of varying lengths representing the values, the cells most likely have 

________ applied to them . 

  a.  themes 

  b.  icon sets 

  c.  data bars 

  d.  cell styles 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-14 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1378 - Create a data bars conditional formatting rule. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:52 AM 

DATE MODIFIED:   6/3/2020 6:40 PM 
 

 

60. Which of the following conditional formats can you apply to display small graphics in a cell that vary based on the 

cell's value? 

  a.  icon sets 

  b.  data bars 

  c.  Highlight Cells Rules 

  d.  color scales 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-14 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1621 - Create an icon set conditional formatting rule. 
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TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 10:56 AM 

DATE MODIFIED:   6/3/2020 6:49 PM 
 

 

61. To search for a picture in the Online Pictures dialog box, you enter a format related to your subject of interest . 

ANSWER:   False - keyword 

False - Keyword 

False - KEYWORD 

False - key word 

False - Key word 

False - Key Word 

False - key Word 

False - KEY WORD 

POINTS:   1 

REFERENCES:   ILEX 2-3 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.7.1.2 - Insert images. 

CORPORATE STANDARDS:   2704 - Insert an online picture. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 11:05 AM 

DATE MODIFIED:   6/3/2020 6:51 PM 
 

 

62. You can create conditional cell formats using either the Home tab or the _____. 

  a.  Quick Analysis tool 

  b.  Cell Styles dialog box 

  c.  Font formatting buttons on the Home tab 

  d.  Number formatting buttons on the Home tab 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-14 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.9.2.1 - Create custom conditional formatting rules. 

CORPORATE STANDARDS:   1368 - Create a conditional formatting rule using the Quick Analysis tool. 

TOPICS:   Illustrated series: Apply Conditional Formatting 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 11:13 AM 

DATE MODIFIED:   8/1/2019 11:31 AM 
 

 

63. Which of the following lets you resize a selected picture on your worksheet? 
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  a.  Drag it to a new location. 

  b.  Drag any corner handle. 

  c.  Drag its top border. 

  d.  Double-click the picture. 

ANSWER:   b 

POINTS:   1 

REFERENCES:   ILEX 2-3 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.7.2.4 - Format Objects 

CORPORATE STANDARDS:   3406 - Resize a picture proportionally. 

TOPICS:   Illustrated series: Format Values 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 11:31 AM 

DATE MODIFIED:   8/26/2019 12:15 AM 
 

 

64. If you want to change all occurrences of "Radio" to "TV" in a worksheet, you can use the _____ command. 

  a.  Replace 

  b.  Find 

  c.  Select 

  d.  Paste 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-18 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.3.1.2 - Replace data. 

CORPORATE STANDARDS:   2196 - Find and replace text. 

TOPICS:   Illustrated series: Check Spelling 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 11:39 AM 

DATE MODIFIED:   6/3/2020 6:29 PM 
 

 

65. To create a workbook containing text, formulas, macros, and formatting that you use repeatedly, you create a _____. 

  a.  master 

  b.  model 

  c.  template 

  d.  standard 

ANSWER:   c 

POINTS:   1 

REFERENCES:   ILEX 2-11 

QUESTION TYPE:   Multiple Choice 
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HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.7.1 - Save workbooks in alternative file formats. 

CORPORATE STANDARDS:   3658 - Save a workbook as a template. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Understand 

DATE CREATED:   8/1/2019 11:47 AM 

DATE MODIFIED:   8/26/2019 12:18 AM 
 

 

66. A workbook template has which of the following file extensions? 

  a.  .xltx 

  b.  .xls 

  c.  .xlsx 

  d.  .xlst 

ANSWER:   a 

POINTS:   1 

REFERENCES:   ILEX 2-11 

QUESTION TYPE:   Multiple Choice 

HAS VARIABLES:   False 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.7.1 - Save workbooks in alternative file formats. 

CORPORATE STANDARDS:   3658 - Save a workbook as a template. 

TOPICS:   Illustrated series: Insert and Delete Rows and Columns 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   8/1/2019 11:52 AM 

DATE MODIFIED:   8/30/2019 2:55 AM 
 

 

67. Use the Application Checker feature to check for formats that could prevent people with disabilities from interacting 

with data or Excel. 

ANSWER:   False - Accessibility 

False - accessibility 

False - ACCESSIBILITY 

POINTS:   1 

REFERENCES:   ILEX 2-13 

QUESTION TYPE:   Modified True / False 

HAS VARIABLES:   False 

STUDENT ENTRY MODE:   Basic 

LEARNING OBJECTIVES:   ILEX.BESK.20.2.6.6 - Inspect a workbook for accessibility issues. 

CORPORATE STANDARDS:   1150 - Check worksheet accessibility. 

TOPICS:   Illustrated Series: Apply Colors, Borders, and Documentation 

KEYWORDS:   Bloom's: Remember 

DATE CREATED:   6/27/2020 4:04 PM 

DATE MODIFIED:   6/27/2020 4:04 PM 
 

 

 


